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Federal Communication Commission Interference 
Statement

For further certification information, please go to www.advantech.com

Declaration of Conformity

CE

This product has passed the CE test for environmental specifications when shielded cables 
are used for external wiring. We recommend the use of shielded cables. This kind of cable is 
available from Advantech. Please contact your local supplier for ordering information.

This product has passed the CE test for environmental specifications. Test conditions for 
passing included the equipment being operated within an industrial enclosure. In order to 
protect the product from being damaged by ESD (Electrostatic Discharge) and EMI leakage, 
we strongly recommend the use of CE-compliant industrial enclosure products.

FCC Class A

This equipment has been tested and found to comply with the limits for a Class A digital 
device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reason-
able protection against harmful interference when the equipment is operated in a commer-
cial environment. This equipment generates, uses, and can radiate radio frequency energy 
and, if not installed and used in accordance with the instruction manual, may cause harmful 
interference to radio communications. Operation of this equipment in a residential area is 
likely to cause harmful interference in which case the user will be required to correct the 
interference at his own expense.

UL

This equipment is suitable for use in Class I, Division 2, Groups A, B, C, and 
D or non-hazardous locations only.

Product Warranty (5 years)

Advantech warrants to you, the original purchaser, that each of its products will be free from 
defects in materials and workmanship for five years from the date of purchase.

This warranty does not apply to any products which have been repaired or altered by per-
sons other than repair personnel authorized by Advantech, or which have been subject to 
misuse, abuse, accident or improper installation. Advantech assumes no liability under the 
terms of this warranty as a consequence of such events.

Because of Advantech’s high quality-control standards and rigorous testing, most of our 
customers never need to use our repair service. If an Advantech product is defective, it will 
be repaired or replaced at no charge during the warranty period. For out of-warranty repairs, 
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you will be billed according to the cost of replacement materials, service time and freight. 
Please consult your dealer for more details.

If you think you have a defective product, follow these steps:

1. Collect all the information about the problem encountered. (For example, CPU speed, 
Advantech products used, other hardware and software used, etc.) Note anything 
abnormal and list any on screen messages you get when the problem occurs.

2. Call your dealer and describe the problem. Please have your manual, product, and any 
helpful information readily available.

3. If your product is diagnosed as defective, obtain an RMA (return merchandize authori-
zation) number from your dealer. This allows us to process your return more quickly.

4. Carefully pack the defective product, a fully-completed Repair and Replacement Order 
Card and a photocopy proof of purchase date (such as your sales receipt) in a shippa-
ble container. A product returned without proof of the purchase date is not eligible for 
warranty service.

5. Write the RMA number visibly on the outside of the package and ship it prepaid to your 
dealer.

Conventions

Copyright

Copyright © 2014 Advantech Inc. All rights reserved. No part of this publication may be 
reproduced, adapted, stored in a retrieval system, translated into any language, or transmit-
ted in any form or by any means without the written permission of the manufacturer.

Warning signs are used to identify immediate hazards for property damage, injury 
or death.

CAUTION SIGNS ARE USED WARN AGAINST POTENTIAL HAZARDS OR TO CAUTION AGAINST 
UNSAFE PRACTICES.

Note signs are used to provide additional information for the device or settings.
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Customer Support

Safety Information

Safety Requirements

Before you begin installing the device, read through the following safety guidelines to pre-
vent personal injury or property damage.

 Seek assistance from a trained professional installer, especially if it is your first time to 
install this device.

 Choose your installation site carefully, noting the location of electric power and circuit 
lines and ensuring that there are no obstructions.

 Do not attempt to service or open the device by yourself. Bring it to a qualified personnel 
or service center for repairs.

 The product was submitted and evaluated for use at the maximum ambient temperature 
(Tma) permitted by the manufacture's specification of: 50°C
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Electrostatic Discharge Requirements

Follow the steps below to protect components from electrostatic discharge:

1. Wear an ESD wrist strap when installing the device.

2. Handle the power adapter by its edge and do not touch any component or printed circuit 
boards.

Temperature/Humidity Requirements

Make sure to keep the temperature and humidity of the installation location at an optimal 
level. Very high temperatures may cause poor insulation, power leakage, mechanical prop-
erty changes, and metal component corrosion. Very high temperatures will also accelerate 
insulation aging, which will greatly degrade reliability and even severely shorten operation 
life.

Under over-low humidity environments, insulation spacers may shrink, resulting in loosening 
of mounting screws. Extremely low humidity may also cause static electricity, which will 
damage the circuit.

Maintenance Requirements

Dust is a major safety hazard for this device. Dust may cause electrostatic absorption, 
resulting in bad contact between metal connectors or metal joints. Electrostatic absorption is 
faster and easier in environments with very low humidity, shortening device life and also 
causing communication failure.

Dust content and particle size requirements are as follows:

Aside from dust, there should be strict limitation on air contained in the room where the 
device is located. Too much salt, acid and sulfide in the air will accelerate metal corrosion 
and aging process of certain components. There should measures to prevent harmful gas 
such as SO2, H2S, NH3 and CI2 from entering the operational environment.

Table 1. Dust Content and Particle Size Requirements

Mechanical Active Substance Content (number/m³)

Dust Particle ≤3×104 (no dust can be seen on desk in three days) 

Dust particle diameter: ≥5µm

Table 2. Maximum Values for Harmful Gases

Gas Max. Value (mg/m³)

SO2 0.2

H2S 0.0006

NH3 0.05

Cl2 0.01
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PoE 

PoE Requirements

This product was in-door used and not connected to outside plant, so user manual shall 
have the description as below or equivalent: "The equipment is to be connected only to PoE 
networks without routing to the outside plant."

Exigences de l'alimentation par Ethernet (PoE)

Ce produit a été utilisé à l'intérieur et il n'a pas été relié à des installations extérieures. Par 
conséquent, le manuel d'utilisation aura la description ci-dessous ou de type équivalent :

« L'appareil doit être relié seulement à des réseaux PoE sans être dirigé vers des installa-
tions extérieures. »

Explosion Hazard

 Do not connect or disconnect equipment unless power has been removed or the area is 
known to be non-hazardous.

 Substitution of any components may impair suitability for Class I, Division 2.

Warnings

 Do NOT place your device near water such as a wet basement.

 Do NOT expose your device to dust, dampness, or corrosive liquids.

 Do NOT place heavy objects on your device.

 Do NOT install, use or service your device during a thunderstorm. There is a remote risk 
of electric shock from lightning.

 Make ONLY suitable connections to your device.

 Make sure all connecting cables from your device are carefully placed.

 Use ONLY an appropriate power adaptor or cord to the right supply voltage.

 Do NOT place any objects on the power adaptor or cord.

 Do NOT use your device when the power adaptor or cord is damaged as it might cause 
electrocution.

 Remove the power adapter or cord from the power outlet when it is damaged.

 Do NOT attempt to repair the power adapter or cord. Contact your local vendor to order 
a new one.

 ONLY use your device indoors. There is a remote risk of electric shock from lightning.

 Do NOT obstruct the ventilation slots of your device, as insufficient airflow may hard it.
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About This Manual

This user manual is intended to guide professional installers in installing and configuring the 
ProView Series Ethernet Switches. It includes technical specifications, software utility intro-
duciton, as we as procedures for the use of the software utility to self-manage the devices.
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Chapter 1
Product Overview



PRODUCT OVERVIEW
1.1. Supported Models

Standard Models:

Wide Temperature Models:

Table 1-1. Standard Models

EKI-5525S EKI-5525M EKI-5525S-ST

EKI-5525M-ST EKI-5524SS EKI-5524MM

EKI-5524SS-ST EKI-5524MM-ST EKI-5525

EKI-5725 EKI-5728 EKI-5729F

EKI-5528 EKI-5526 EKI-5726

EKI-5726F EKI-5629C EKI-5626C

Table 1-2. Wide Temperature Models

EKI-5525SI EKI-5525MI EKI-5525SI-ST

EKI-5525MI-ST EKI-5524SSI EKI-5524MMI

EKI-5524SSI-ST EKI-5524MMI-ST EKI-5525I

EKI-5725I EKI-5728I EKI-5729FI

EKI-5728P EKI-5725P EKI-5725FP

EKI-5528I EKI-5526I EKI-5726I

EKI-5726FI EKI-5629CI EKI-5626CI
1



PRODUCT OVERVIEW
1.2. Specifications

Table 1-3. Specifications

Specifications Description

Interface I/O Port  EKI-5525S/EKI-5525SI: 4 x RJ45 + 1 x SC (single 
mode)

 EKI-5525M/EKI-5525MI: 4 x RJ45 + 1 x SC (multi 
mode)

 EKI-5525S-ST/EKI-5525SI-ST: 4 x RJ45 + 1 x ST 
(single mode)

 EKI-5525M-ST/EKI-5525MI-ST: 4 x RJ45 + 1 x ST 
(multi mode)

 EKI-5524SS/EKI-5524SSI: 4 x RJ45 + 2 x SC (single 
mode)

 EKI-5524MM/EKI-5524MMI: 4 x RJ45 + 2 x SC (multi 
mode)

 EKI-5524SS-ST/EKI-5524SSI-ST: 4 x RJ45 + 2 x ST 
(single mode)

 EKI-5524MM-ST/EKI-5524MMI-ST: 4 x RJ45 + 2 x 
ST (multi mode)

 EKI-5525/EKI-5525I: 5 x 10/100BaseT(X)

 EKI-5725/EKI-5725I: 5 x 10/100/1000BaseT(X)

 EKI-5728/EKI-5728I: 8 x 10/100/1000BaseT(X)

 EKI-5729F/EKI-5729FI: 8 x 10/100/1000BaseT(X) + 
2 x 100/1000Base-FX SFP

 EKI-5728P: 8 x 10/100/1000BaseT(X) with PoE

 EKI-5725P: 5 x 10/100/1000BaseT(X) with 4 port 
PoE

 EKI-5725FP: 4 x 10/100/1000BaseT(X) with PoE + 
1 x 100/1000FX

 EKI-5528/EKI-5528I: 8 x 10/100BaseT(X)

 EKI-5526/EKI-5526I: 16 x 10/100BaseT(X)

 EKI-5726/EKI-5726I: 16 x 10/100/1000BaseT(X)

 EKI-5726F/EKI-5726FI: 16 x 10/100/1000BaseT(X) + 
2 x 100/1000FX

 EKI-5629C/EKI-5629CI: 8 x 10/100BaseT(X) + 2 x 
10/100/1000Base-T(X) or 100/1000Base-X SFP Port

 EKI-5626C/EKI-5626CI: 16 x 10/100BaseT(X) + 2 x 
10/100/1000Base-T(X) or 100/1000Base-X SFP Port 

Power Connector 6-pin screw Terminal Block (including relay)
2



PRODUCT OVERVIEW
Physical Enclosure Metal Shell

Protection Class IP30

Installation DIN-Rail and Wall-Mount

Dimensions 
(W x H x D)

 EKI-5525S/EKI-5525SI: 27mm x 120mm x 84mm

 EKI-5525M/EKI-5525MI: 27mm x 120mm x 84mm

 EKI-5525S-ST/EKI-5525SI-ST: 27mm x 120mm x 
84mm

 EKI-5525M-ST/EKI-5525MI-ST: 27mm x 120mm x 
84mm

 EKI-5524SS: 28.5mm x 120mm x 85.3mm

 EKI-5524SSI: 28.5mm x 120mm x 85.3mm

 EKI-5524MM/EKI-5524MMI: 28.5mm x 120mm x 
85.3mm

 EKI-5524SS-ST/EKI-5524SSI-ST: 28.5mm x 120mm 
x 85.3mm

 EKI-5524MM-ST/EKI-5524MMI-ST: 28.5mm x 
120mm x 85.3mm

 EKI-5525/EKI-5525I: 27mm x 120mm x 84mm

 EKI-5725/EKI-5725I: 27mm x 120mm x 84mm

 EKI-5728/EKI-5728I: 43mm x 120mm x 84mm

 EKI-5729F/EKI-5729FI: 43mm x 120mm x 84mm

 EKI-5728P: 68mm x 152mm x 105mm

 EKI-5725P: 68mm x 152mm x 105mm

 EKI-5725FP: 68mm x 152mm x 105mm

 EKI-5528/EKI-5528I: 43mm x 120mm x 84mm

 EKI-5526/EKI-5526I: 74mm x 120mm x 84mm

 EKI-5726/EKI-5726I: 74mm x 120mm x 84mm

 EKI-5726F/EKI-5726FI: 74mm x 120mm x 84mm

 EKI-5629C/EKI-5629CI: 74mm x 120mm x 84mm

 EKI-5626C/EKI-5626CI: 74mm x 120mm x 84mm

LED Display System LED PWR1, PWR2, P-fail, Loop detection

PoE (only for EKI-5728P, EKI-5725P and EKI-5725FP)

Port LED Link / Speed / Activity

PoE (only for EKI-5728P, EKI-5725P and EKI-5725FP)

Table 1-3. Specifications (Continued)

Specifications Description
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PRODUCT OVERVIEW
Environment Operating Tem-
perature

 Wide Temperature Models: -40°C to 75°C (-40°F to 
167°F)

 Standard Models: -10°C to 60°C (14°F to 140°F)

Storage Tempera-
ture

-40°C ~ 85° C (-40°F ~ 185° F)

Ambient Relative 
Humidity

10 ~ 95% (non-condensing)

Switch Properties MAC Address  EKI-5525S/EKI-5525SI: 2K entries

 EKI-5525M/EKI-5525MI: 2K entries

 EKI-5525S-ST/EKI-5525SI-ST: 2K entries

 EKI-5525M-ST/EKI-5525MI-ST: 2K entries

 EKI-5524SS/EKI-5524SSI: 2K entries

 EKI-5524MM/EKI-5524MMI: 2K entries

 EKI-5524SS-ST/EKI-5524SSI-ST: 2K entries

 EKI-5524MM-ST/EKI-5524MMI-ST: 2K entries

 EKI-5525/EKI-5525I: 2K entries

 EKI-5725/EKI-5725I: 2K entries

 EKI-5728/EKI-5728I: 8K entries

 EKI-5729F/EKI-5729FI: 8K entries

 EKI-5728P: 8K entries

 EKI-5725P: 8K entries

 EKI-5725FP: 2K entries

 EKI-5528/EKI-5528I: 8K entries

 EKI-5526/EKI-5526I: 8K entries

 EKI-5726/EKI-5726I: 8K entries

 EKI-5726F/EKI-5726FI: 8K entries

 EKI-5629C/EKI-5629CI: 8K entries

 EKI-5626C/EKI-5626CI: 8K entries

Table 1-3. Specifications (Continued)

Specifications Description
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PRODUCT OVERVIEW
Switch Properties Switching Band-
width

 EKI-5525S/EKI-5525SI: 1 Gbps

 EKI-5525M/EKI-5525MI: 1 Gbps

 EKI-5525S-ST/EKI-5525SI-ST: 1 Gbps

 EKI-5525M-ST/EKI-5525MI-ST: 1 Gbps

 EKI-5524SS/EKI-5524SSI: 1.2 Gbps

 EKI-5524MM/EKI-5524MMI: 1.2 Gbps

 EKI-5524SS-ST/EKI-5524SSI-ST: 1.2 Gbps

 EKI-5524MM-ST/EKI-5524MMI-ST: 1.2 Gbps

 EKI-5525/EKI-5525I: 1 Gbps

 EKI-5725/EKI-5725I: 10 Gbps

 EKI-5728/EKI-5728I: 16 Gbps

 EKI-5729F/EKI-5729FI: 20 Gbps

 EKI-5728P: 16 Gbps

 EKI-5725P: 10 Gbps

 EKI-5725FP: 10 Gbps

 EKI-5528/EKI-5528I: 1.6 Gbps

 EKI-5526/EKI-5526I: 3.2 Gbps

 EKI-5726/EKI-5726I: 32 Gbps

 EKI-5726F/EKI-5726FI: 36 Gbps

 EKI-5629C/EKI-5629CI: 5.6 Gbps

 EKI-5626C/EKI-5626CI: 7.2 Gbps

Table 1-3. Specifications (Continued)

Specifications Description
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PRODUCT OVERVIEW
Power Power Consump-
tion

 EKI-5525S/EKI-5525SI: 2.8 watts

 EKI-5525M/EKI-5525MI: 2.8 watts

 EKI-5525S-ST/EKI-5525SI-ST: 2.8 watts

 EKI-5525M-ST/EKI-5525MI-ST: 2.8 watts

 EKI-5524SS/EKI-5524SSI: 4 watts

 EKI-5524MM/EKI-5524MMI: 4 watts

 EKI-5524SS-ST/EKI-5524SSI-ST: 4 watts

 EKI-5524MM-ST/EKI-5524MMI-ST: 4 watts

 EKI-5525/EKI-5525I: 2 watts

 EKI-5725/EKI-5725I: 2 watts

 EKI-5728/EKI-5728I: 5.2 watts

 EKI-5729F/EKI-5729FI: 6.8 watts

 EKI-5728P: TBD

 EKI-5725P: TBD

 EKI-5725FP: TBD

 EKI-5528/EKI-5528I: 3.6 watts

 EKI-5526/EKI-5526I: 3.84 watts

 EKI-5726/EKI-5726I: 8 watts

 EKI-5726F/EKI-5726FI: 9.6 watts

 EKI-5629C/EKI-5629CI: 5.8 watts

 EKI-5626C/EKI-5626CI: 8.2 watts

Power Input  12V~48V (8.4V to 52.8V), redundant dual inputs

 24V~48V (16.8V ~ 62.4V) +/- 30%  (only for EKI-
5728P, EKI-5725P and EKI-5725FP)

Table 1-3. Specifications (Continued)

Specifications Description
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PRODUCT OVERVIEW
Certifications EMC  CE, FCC Part15 Subpart B Class A

 EN 55011/55022 Class A

 IEC/EN 60950, UL90950, UL508, Class 1 Division 2, 
ATEX

 EN 61000-4-2 (Level 3)

 EN 61000-4-3 (Level 3)

 EN 61000-4-4 (Level 3)

 EN 61000-4-5 (Level 3)

 EN 61000-4-6 (Level 3)

 EN 61000-4-8 (Level 3)

Shock IEC60068-2-27

Freefall IEC60068-2-32

Vibration IEC60068-2-6

Table 1-3. Specifications (Continued)

Specifications Description
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PRODUCT OVERVIEW
1.3. Hardware Views

1.3.1 Front View

The following view applies to:

Figure 1-1. Front View

Table 1-4. Support Models

EKI-5525 EKI-5525I EKI-5725

EKI-5725I

Table 1-5. Front View

No. Item Description

1 System LED panel See “System LED Panel” on page 30 for further details.

2 ETH port EKI-5525/EKI-5525I: Four 10/100BaseT(X) ports.

EKI-5725/EKI-5725I: Four 10/100/1000BaseT(X) ports.

Port numbers in black are designated for Quality of Service (QoS) 
functionality.

3 LNK/ACT LED Link activity LED.

3

4

5

P2P1 P-Fail

Loop

1

2

EKI-5725

1

2

5

3

4
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PRODUCT OVERVIEW
4 Speed LED  Gigabit Ethernet:

 Green: 1000M

 Amber: 100M

 Blinking: 10M

 Fast Ethernet:

 Amber: 100M

 Blinking: 10M

5 ETH port EKI-5525/EKI-5525I: One 10/100BaseT(X) port.

EKI-5725/EKI-5725I: One 10/100/1000Base-T/RJ45 port.

Table 1-5. Front View (Continued)

No. Item Description
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PRODUCT OVERVIEW
The following view applies to:

Figure 1-2. Front View

Table 1-6. Support Models

EKI-5528 EKI-5528I EKI-5728

EKI-5728I

Table 1-7. Front View

No. Item Description

1 System LED panel See “System LED Panel” on page 30 for further details.

2 ETH port EKI-5528/EKI-5528I: Eight 10/100BaseT(X) ports.

EKI-5728/EKI-5728I: Eight 10/100/1000BaseT(X) ports.

Port numbers in black are designated for Quality of Service (QoS) 
functionality.

3 LNK/ACT LED Link activity LED.

P2P1 P-Fail

Loop

8

7

6

5

3

4

1

2

EKI-55285528I

1

2

3

4

10



PRODUCT OVERVIEW
The following view applies to:

Figure 1-3. Front View

4 Speed LED  Gigabit Ethernet:

 Green: 1000M

 Amber: 100M

 Blinking: 10M

 Fast Ethernet:

 Amber: 100M

 Blinking: 10M

Table 1-8. Support Models

EKI-5729F EKI5729FI

Table 1-9. Front View

No. Item Description

1 System LED panel See “System LED Panel” on page 30 for further details.

Table 1-7. Front View (Continued)

No. Item Description

P2P1 P-Fail

Loop

8

7

6

5

3

4
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1

2

EKI-5729F

1

2

5

3

4

11



PRODUCT OVERVIEW
2 ETH port Eight 10/100/1000BaseT(X) ports.

Port numbers in black are designated for Quality of Service (QoS) 
functionality.

3 LNK/ACT LED Link activity LED.

4 Speed LED  Gigabit Ethernet:

 Green: 1000M

 Amber: 100M

 Blinking: 10M

 Fast Ethernet:

 Amber: 100M

 Blinking: 10M

5 ETH port Two 100/1000Base-FX SFP ports.

Table 1-9. Front View (Continued)

No. Item Description
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PRODUCT OVERVIEW
The following view applies to:

Figure 1-4. Front View

Table 1-10. Support Models

EKI-5525S EKI-5525SI EKI-5525M

EKI-5525MI

Table 1-11. Front View

No. Item Description

1 System LED panel See “System LED Panel” on page 30 for further details.

2 ETH port Four RJ45 ports.

Port numbers in black are designated for Quality of Service (QoS) 
functionality.

3 LNK/ACT LED Link activity LED.

3

4

5

P2P1 P-Fail

Loop

1

2

EKI-5525SI525SI

1

2

5

3

4
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PRODUCT OVERVIEW
4 Speed LED  Gigabit Ethernet:

 Green: 1000M

 Amber: 100M

 Blinking: 10M

 Fast Ethernet:

 Amber: 100M

 Blinking: 10M

5 SC port EKI-5525S/EKI-5525SI: One SC (single mode) port

EKI-5525M/EKI-5525MI: One SC (multi mode) port

Table 1-11. Front View (Continued)

No. Item Description
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PRODUCT OVERVIEW
The following view applies to:

Figure 1-5. Front View

Table 1-12. Support Models

EKI-5525S-ST EKI-5525SI-ST EKI-5525M-ST

EKI-5525MI-ST

Table 1-13. Front View

No. Item Description

1 System LED panel See “System LED Panel” on page 30 for further details.

2 ETH port Four RJ45 ports.

Port numbers in black are designated for Quality of Service (QoS) 
functionality.

3 LNK/ACT LED Link activity LED.

3

4

5

P2P1 P-Fail

Loop

1

2

EKI-5525SI-ST525SI-ST

1

2

5

3

4
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PRODUCT OVERVIEW
4 Speed LED  Gigabit Ethernet:

 Green: 1000M

 Amber: 100M

 Blinking: 10M

 Fast Ethernet:

 Amber: 100M

 Blinking: 10M

5 ST port EKI-5525S-ST/EKI-5525SI-ST: One ST (single mode) port.

EKI-5525M-ST/EKI-5525MI-ST: One ST (multi mode) port.

Table 1-13. Front View (Continued)

No. Item Description
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PRODUCT OVERVIEW
The following view applies to:

Figure 1-6. Front View

Table 1-14. Support Models

EKI-5524SS EKI-5524SSI EKI-5524MM

EKI-5524MMI

Table 1-15. Front View

No. Item Description

1 System LED panel See “System LED Panel” on page 30 for further details.

2 ETH port Four RJ45 ports.

Port numbers in black are designated for Quality of Service (QoS) 
functionality.

3 LNK/ACT LED Link activity LED.

P2P1 P-Fail

Loop

EKI-5524SSI5524SSI

3

4

5

1

2

6

1

2

3

4

5
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PRODUCT OVERVIEW
4 Speed LED  Gigabit Ethernet:

 Green: 1000M

 Amber: 100M

 Blinking: 10M

 Fast Ethernet:

 Amber: 100M

 Blinking: 10M

5 ST port EKI-5524SS/EKI-5524SSI: Two SC (single mode) ports.

EKI-5524MM/EKI-5524MMI: Two SC (multi mode) ports.

Table 1-15. Front View (Continued)

No. Item Description
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PRODUCT OVERVIEW
The following view applies to:

Figure 1-7. Front View

Table 1-16. Support Models

EKI-5524SS-ST EKI-5524SSI-ST EKI-5524MM-ST

EKI-5524MMI-ST

Table 1-17. Front View

No. Item Description

1 System LED panel See “System LED Panel” on page 30 for further details.

2 ETH port Four RJ45 ports.

Port numbers in black are designated for Quality of Service (QoS) 
functionality.

3 LNK/ACT LED Link activity LED.

P2P1 P-Fail

Loop

EKI-5524SSI-ST5524SSI-ST

3

4

5

1

2

6

1

2

3

4

5
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PRODUCT OVERVIEW
4 Speed LED  Gigabit Ethernet:

 Green: 1000M

 Amber: 100M

 Blinking: 10M

 Fast Ethernet:

 Amber: 100M

 Blinking: 10M

5 ST port EKI-5524SS/EKI-5524SSI: Two ST (single mode) ports.

EKI-5524MM/EKI-5524MMI: Two ST (multi mode) ports.

Table 1-17. Front View (Continued)

No. Item Description
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PRODUCT OVERVIEW
The following view applies to:

Figure 1-8. Front View

Table 1-18. Support Models

EKI-5526 EKI-5526I EKI-5726

EKI-5726I

Table 1-19. Front View

No. Item Description

1 System LED panel See “System LED Panel” on page 30 for further details.

2 ETH port EKI-5526/EKI-5526I: Sixteen 10/100BaseT(X) ports.

EKI-5726/EKI-5726I: Sixteen 10/100/1000BaseT(X) ports.

Port numbers in black are designated for Quality of Service (QoS) 
functionality.

3 LNK/ACT LED Link activity LED.

P2P1 P-Fail

Loop

8

7

6

5

12

11

10

9

16

15

14

13

3

4

1

2

EKI-5526

1

2

3

4
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PRODUCT OVERVIEW
The following view applies to:

Figure 1-9. Front View

4 Speed LED  Gigabit Ethernet:

 Green: 1000M

 Amber: 100M

 Blinking: 10M

 Fast Ethernet:

 Amber: 100M

 Blinking: 10M

Table 1-20. Support Models

EKI-5629C EKI-5629CI

Table 1-21. Front View

No. Item Description

1 System LED panel See “System LED Panel” on page 30 for further details.

Table 1-19. Front View (Continued)

No. Item Description

P2P1 P-Fail

Loop

8

7

6

5
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3

4

1

2

EKI-5629C5629C

9

10

1

2

5

3

4
5

6

6
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PRODUCT OVERVIEW
2 ETH port Eight 10/100BaseT(X) ports.

Port numbers in black are designated for Quality of Service (QoS) 
functionality.

3 LNK/ACT LED Link activity LED.

4 Speed LED  Gigabit Ethernet:

 Green: 1000M

 Amber: 100M

 Blinking: 10M

 Fast Ethernet:

 Amber: 100M

 Blinking: 10M

5 ETH port Two 10/100/1000BaseT(X) ports.

6 ETH port Two 100/1000Base-X SFP ports.

Table 1-21. Front View (Continued)

No. Item Description
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PRODUCT OVERVIEW
The following view applies to:

Figure 1-10. Front View

Table 1-22. Support Models

EKI-5626C EKI-5626CI

Table 1-23. Front View

No. Item Description

1 System LED panel See “System LED Panel” on page 30 for further details.

2 ETH port Eight 10/100BaseT(X) ports.

Port numbers in black are designated for Quality of Service (QoS) 
functionality.

3 LNK/ACT LED Link activity LED.

4 Speed LED  Gigabit Ethernet:

 Green: 1000M

 Amber: 100M

 Blinking: 10M

 Fast Ethernet:

 Amber: 100M

 Blinking: 10M

P2P1 P-Fail

Loop

8

7

6

5

12

11

10

9

16

17 18

15

14

13

3

4

1

2

EKI-5626CI6CI

1

2

5

3

4

6
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PRODUCT OVERVIEW
The following view applies to:

Figure 1-11. Front View

5 ETH port Two 10/100/1000BaseT(X) ports.

6 ETH port Two 100/1000Base-X SFP ports.

Table 1-24. Support Models

EKI-5726F EKI-5726FI

Table 1-25. Front View

No. Item Description

1 System LED panel See “System LED Panel” on page 30 for further details.

2 ETH port Sixteen 16 10/100/1000BaseT(X) ports.

Port numbers in black are designated for Quality of Service (QoS) 
functionality.

3 LNK/ACT LED Link activity LED.

Table 1-23. Front View (Continued)

No. Item Description

P2P1 P-Fail

Loop

8

7

6

5

12

11

10

9

16

15

14

13

3

4

1817

1

2

EKI-5726F726F

1

2

5

3

4
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PRODUCT OVERVIEW
The following view applies to:

Figure 1-12. Front View

4 Speed LED  Gigabit Ethernet:

 Green: 1000M

 Amber: 100M

 Blinking: 10M

 Fast Ethernet:

 Amber: 100M

 Blinking: 10M

5 ETH port Two 100/1000FX ports.

Table 1-26. Support Models

EKI-5725P

Table 1-27. Front View

No. Item Description

1 ETH port Four 10/100/1000BaseT with PoE ports.

2 LNK/ACT LED Link activity LED.

Table 1-25. Front View (Continued)

No. Item Description

P1

P2

P-Fail

Loop

PoE
1
2
3
4

3

4

1

2

EKI-5725P5P

45

5

1

2

3

4
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PRODUCT OVERVIEW
3 Speed LED  Gigabit Ethernet:

 Green: 1000M

 Amber: 100M

 Blinking: 10M

 Fast Ethernet:

 Amber: 100M

 Blinking: 10M

4 ETH port One 10/100/1000BaseT port..

5 System LED panel See “System LED Panel (Only for EKI-5728P, EKI-5725P and EKI-
5725FP)” on page 31 for further details.

Table 1-27. Front View (Continued)

No. Item Description
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PRODUCT OVERVIEW
The following view applies to:

Figure 1-13. Front View

Table 1-28. Support Models

EKI-5725FP

Table 1-29. Front View

No. Item Description

1 ETH port Four 10/100/1000BaseT with PoE ports.

2 LNK/ACT LED Link activity LED.

3 Speed LED  Gigabit Ethernet:

 Green: 1000M

 Amber: 100M

 Blinking: 10M

 Fast Ethernet:

 Amber: 100M

 Blinking: 10M

4 ETH port One 100/1000FX port.

5 System LED panel See “System LED Panel (Only for EKI-5728P, EKI-5725P and EKI-
5725FP)” on page 31 for further details.

P1

P2

P-Fail

Loop

PoE
1
2
3
4

3

4

1

2

EKI-5725P5P

45

5

1

2

3

4
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PRODUCT OVERVIEW
The following view applies to:

Figure 1-14. Front View

Table 1-30. Support Models

EKI-5728P

Table 1-31. Front View

No. Item Description

1 ETH port Eight 10/100/1000BaseT(X) with PoE ports.

2 LNK/ACT LED Link activity LED.

3 Speed LED  Gigabit Ethernet:

 Green: 1000M

 Amber: 100M

 Blinking: 10M

 Fast Ethernet:

 Amber: 100M

 Blinking: 10M

4 System LED panel See “System LED Panel (Only for EKI-5728P, EKI-5725P and EKI-
5725FP)” on page 31 for further details.

P1

P2

P-Fail

Loop

PoE
1
2
3
4
5
6
7
8

EKI-5728P8P

8

7

6

5

3

4

1

2

4

1

2

3
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PRODUCT OVERVIEW
System LED Panel

Figure 1-15. System LED Panel

Table 1-32. System LED Panel

No. LED Name LED Color Description

1 PW1 LED Solid green Powered up.

Off Powered down or not installed.

2 PW2 LED Solid green Powered up.

Off Powered down or not installed.

3 P-fail Solid red Detects PW1 and PW2, if connected LED lights.

Off Detects PW1 and PW2, if disconnected LED does not 
light.

4 Loop Solid red Detects state and lights if active.

Off No loop detected.

P2P1 P-Fail

Loop

1 2 3 4
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PRODUCT OVERVIEW
System LED Panel (Only for EKI-5728P, EKI-5725P and EKI-5725FP)

Figure 1-16. System LED Panel

Table 1-33. System LED Panel

No. LED Name LED Color Description

1 PW1 LED Solid green Powered up.

Off Powered down or not installed.

2 PW2 LED Solid green Powered up.

Off Powered down or not installed.

3 P-fail Solid red Detects PW1 and PW2, if connected LED lights.

Off Detects PW1 and PW2, if disconnected LED does not 
light.

4 Loop Solid red Detects state and lights if active.

Off No loop detected.

5 PoE (depending 
the PoE ports)

P1

P2

P-Fail

Loop

PoE
1
2
3
4

1

2

3

4

5
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PRODUCT OVERVIEW
1.3.2 Rear View

The following view applies to:

Figure 1-17. Rear View

Table 1-34. Support Models

EKI-5525S EKI-5525SI EKI-5525M

EKI-5525MI EKI-5525S-ST EKI-5525SI-ST

EKI-5525M-ST EKI-5525MI-ST EKI-5524SS

EKI-5524SSI EKI-5524MM EKI-5524MMI

EKI-5524SS-ST EKI-5524SSI-ST EKI-5524MM-ST

EKI-5524MMI-ST EKI-5525 EKI-5525I

EKI-5725 EKI-5725I

Table 1-35. Rear View

No. Item Description

1 DIN-Rail mounting 
plate

Mounting plate used for the installation to a standard DIN rail.

1

32



PRODUCT OVERVIEW
The following view applies to:

Figure 1-18. Rear View

Table 1-36. Support Models

EKI-5728 EKI-5728I EKI-5729F

EKI-5729FI EKI-5528 EKI-5528I

Table 1-37. Rear View

No. Item Description

1 DIN-Rail mounting 
plate

Mounting plate used for the installation to a standard DIN rail.

1
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PRODUCT OVERVIEW
The following view applies to:

Figure 1-19. Rear View

Table 1-38. Support Models

EKI-5526 EKI-5526I EKI-5629C

EKI-5629CI EKI-5626C EKI-5626CI

EKI-5726 EKI-5726I EKI-5726F

EKI-5726FI EKI-5725FP EKI-5725P

EKI-5728P

Table 1-39. Rear View

No. Item Description

1 DIN-Rail mounting 
plate

Mounting plate used for the installation to a standard DIN rail.

1
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PRODUCT OVERVIEW
1.3.3 Top View

The following view applies to:

Figure 1-20. Top View

Table 1-40. Support Models

EKI-5525S EKI-5525SI EKI-5525M

EKI-5525MI EKI-5525S-ST EKI-5525SI-ST

EKI-5525M-ST EKI-5525MI-ST EKI-5524SS

EKI-5524SSI EKI-5524MM EKI-5524MMI

EKI-5524SS-ST EKI-5524SSI-ST EKI-5524MM-ST

EKI-5524MMI-ST EKI-5525 EKI-5525I

EKI-5725 EKI-5725I

Table 1-41. Top View

No. Item Description

1 Terminal block Connect cabling for power and alarm wiring.

P-Fail
V2-

PWR2DC 12-48V 1A@24V PWR1

V2+ V1- V1+

1
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PRODUCT OVERVIEW
The following view applies to:

Figure 1-21. Top View

Table 1-42. Support Models

EKI-5728 EKI-5728I EKI-5729F

EKI-5729FI EKI-5528 EKI-5528I

Table 1-43. Top View

No. Item Description

1 Terminal block Connect cabling for power and alarm wiring.

P-Fail
V2-

PWR2DC 12-48V 1A@24V PWR1

V2+ V1- V1+

1
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PRODUCT OVERVIEW
The following view applies to:

Figure 1-22. Top View

Table 1-44. Support Models

EKI-5526 EKI-5526I EKI-5629C

EKI-5629CI EKI-5626C EKI-5626CI

EKI-5726 EKI-5726I EKI-5726F

EKI-5726FI EKI-5725FP EKI-5725P

EKI-5728P

Table 1-45. Top View

No. Item Description

1 Terminal block Connect cabling for power and alarm wiring.

P-Fail
V2-

PWR2DC 12-48V 1A@24V PWR1

V2+ V1- V1+

1
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PRODUCT OVERVIEW
1.3.4 Bottom View

The following view applies to:

Figure 1-23. Bottom View

Table 1-46. Support Models

EKI-5525S EKI-5525SI EKI-5525M

EKI-5525MI EKI-5525S-ST EKI-5525SI-ST

EKI-5525M-ST EKI-5525MI-ST EKI-5524SS

EKI-5524SSI EKI-5524MM EKI-5524MMI

EKI-5524SS-ST EKI-5524SSI-ST EKI-5524MM-ST

EKI-5524MMI-ST EKI-5525 EKI-5525I

EKI-5725 EKI-5725I

Table 1-47. Bottom View

No. Item Description

1 Ground terminal Screw terminal used to ground chassis.

1
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PRODUCT OVERVIEW
The following view applies to:

Figure 1-24. Bottom View

Table 1-48. Support Models

EKI-5728 EKI-5728I EKI-5729F

EKI-5729FI EKI-5528 EKI-5528I

Table 1-49. Bottom View

No. Item Description

1 Ground terminal Screw terminal used to ground chassis.

1
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PRODUCT OVERVIEW
The following view applies to:

Figure 1-25. Bottom View

Table 1-50. Support Models

EKI-5526 EKI-5526I EKI-5629C

EKI-5629CI EKI-5626C EKI-5626CI

EKI-5726 EKI-5726I EKI-5726F

EKI-5726FI EKI-5725FP EKI-5725P

EKI-5728P

Table 1-51. Bottom View

No. Item Description

1 Ground terminal Screw terminal used to ground chassis.

1
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PRODUCT OVERVIEW
1.4. Dimensions

The following view applies to:

Figure 1-26. Dimensions for Front View

Table 1-52. Support Models

EKI-5525S EKI-5525SI EKI-5525M

EKI-5525MI EKI-5525S-ST EKI-5525SI-ST

EKI-5525M-ST EKI-5525MI-ST EKI-5525

EKI-5525I EKI-5725 EKI-5725I

Table 1-53. Support Models

EKI-5524SS EKI-5524SSI EKI-5524MM

EKI-5524MMI EKI-5524SS-ST EKI-5524SSI-ST

EKI-5524MM-ST EKI-5524MMI-ST

27mm
1.06inch

120mm
4.72inch
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PRODUCT OVERVIEW
Figure 1-27. Dimensions for Front View

28.5mm
1.12inch

120mm
4.72inch
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PRODUCT OVERVIEW
The following view applies to:

Figure 1-28. Dimensions for Front View

Table 1-54. Support Models

EKI-5728 EKI-5728I EKI-5729F

EKI-5729FI EKI-5528 EKI-5528I

43mm
1.69inch

120mm
4.72inch
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PRODUCT OVERVIEW
The following view applies to:

Figure 1-29. Dimensions for Front View

Table 1-55. Support Models

EKI-5526 EKI-5526I EKI-5629C

EKI-5629CI EKI-5626C EKI-5626CI

EKI-5726 EKI-5726I EKI-5726F

EKI-5726FI

74mm
2.91inch

120mm
4.72inch
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PRODUCT OVERVIEW
The following view applies to:

Figure 1-30. Dimensions for Front View

Table 1-56. Support Models

EKI-5725FP EKI-5725P EKI-5728P

68mm
2.68inch

152mm
5.98inch
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PRODUCT OVERVIEW
The following view applies to:

Figure 1-31. Dimensions for Side View

Table 1-57. Support Models

EKI-5525S EKI-5525SI EKI-5525M

EKI-5525MI EKI-5525S-ST EKI-5525SI-ST

EKI-5525M-ST EKI-5525MI-ST EKI-5524SS

EKI-5524SSI EKI-5524MM EKI-5524MMI

EKI-5524SS-ST EKI-5524SSI-ST EKI-5524MM-ST

EKI-5524MMI-ST EKI-5525 EKI-5525I

EKI-5725 EKI-5725I EKI-5728

EKI-5728I EKI-5729F EKI-5729FI

EKI-5528 EKI-5528I EKI-5526

EKI-5526I EKI-5629C EKI-5629CI

EKI-5626C EKI-5626CI EKI-5726

EKI-5726I EKI-5726F EKI-5726FI

84mm
3.31inch
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PRODUCT OVERVIEW
The following view applies to:

Figure 1-32. Dimensions for Side View

Table 1-58. Support Models

EKI-5725FP EKI-5725P EKI-5728P

105mm
4.13inch
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Chapter 2
Switch Installation



SWITCH INSTALLATION
2.1. Installation Guidelines

The following guidelines are provided to optimize the device performance. Review the 
guidelines before installing the device.

 Make sure cabling is away from sources of electrical noise. Radios, power lines, and flu-
orescent lighting fixtures can interference with the device performance.

 Make sure the cabling is positioned away from equipment that can damage the cables.

 Operating environment is within the ranges listed range, see “Specifications” on page 2.

 Relative humidity around the switch does not exceed 95 percent (noncondensing).

 Altitude at the installation site is not higher than 10,000 feet.

 In 10/10 and 10/100/1000 fixed port devices, the cable length from the switch to con-
nected devices can not exceed 100 meters (328 feet).

 Make sure airflow around the switch and respective vents is unrestricted. Without 
proper airflow the switch can overheat. To prevent performance degredation and dam-
age to the switch, make sure there is clerance at the top and bottom and around the 
exhaust vents. 

2.1.1 Connecting Hardware

In this instruction, it will explain how to find a proper location for your Modbus Gateways, 
and how to connect to the network, hock up the power cable, and connect to the EKI-5000 
Series.

2.2. Verifying Switch Operation

Before installing the device in a rack or on a wall, power on the switch to verify that the 
switch passes the power-on self-test (POST). To connect the cabling to the power source 
see “Power Supply Installation” on page 57. 

At startup (POST), the System LED blinks green, while the remaining LEDs are a solidy 
green. Once the switch passes POST self-test, the System LED turns green. The other 
LEDs turn off and return to their operating status. If the switch fails POST, the System LED 
switches to an amber state.

After a successful self-test, power down the switch and disconnect the power cabling. 

The switch is now ready for installation on its final location.

2.3. Installing the Switch

2.3.1 DIN Rail Mounting

The DIN rail mount option is the quickest installation option. Additionally, it optimizes the use 
of rail space.
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SWITCH INSTALLATION
The metal DIN rail kit is secured to the rear of the switch. The device can be mounted onto a 
standard 35mm (1.37”) x 75 mm (3”) height DIN rail. The devices can be mounted vertically 
or horizontally. Refer to the following guidelines for further information.

Installing the DIN-Rail Mounting Kit

1. Insert the top back of the mounting bracket over the DIN rail.

2. Push the bottom of the switch towards the DIN rail until it snaps into place.
\

Figure 2-1. Installing the DIN-Rail Mounting Kit

Removing the DIN-Rail Mounting Kit

1. Push the switch down to free the bottom of the plate from the DIN rail.

2. Rotate the bottom of the device towards you and away from the DIN rail.

A corrosion-free mounting rail is advisable.

When installing, make sure to allow for enough space to properly install the cabling.

2

1

DIN Rail
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SWITCH INSTALLATION
3. Once the bottom is clear of the DIN rail, lift the device straight up to unhook it from the 
DIN rail.

\

Figure 2-2. Removing the DIN-Rail

2.3.2 Wall-Mounting

The wall mounting option provides better shock and vibration resistance than the DIN rail 
vertical mount.

Before the device can be mounted on a wall, you will need to remove the DIN rail plate.

1. Rotate the device to the rear side and locate the DIN mounting plate.

2. Remove the screws securing the DIN mounting plate to the rear panel of the switch.

3. Remove the DIN mounting plate. Store the DIN mounting plate and provided screws for 
later use.

4. Align the wall mounting plates on the rear side. The screw holes on the device and the 
mounting plates must be aligned, see the following illustration.

When installing, make sure to allow for enough space to properly install the cabling.

2

1

DIN Rail
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5. Secure the wall mount plates with M3 screws, see the following figure.

Figure 2-3. Installing Wall Mount Plates

Once the wall mounting plates are secure on the device, you will need to attach the wall 
screws (x4).

6. Locate the installation site and place the switch against the wall, making sure it is the 
final installation location.

7. Use the wall mount plates as a guide to mark the locations of the screw holes.

8. Drill four holes over the four marked locations on the wall, keeping in mind that the holes 
must accommodate wall sinks in addition to the screws.

9. Insert the wall sinks into the walls.

10. Insert the screws into the wall sinks. Leave a 6mm gap between the wall and the screw 
head to allow for wall mount plate insertion.

Figure 2-4. Securing Wall Mounting Screws

11. Align the wall mount plate over the screws on the wall.

 Make sure the screws dimensions are suitable for use with the wall mounting plate.

 Do not completely tighten the screws into the wall. A final adjustment may be needed 
before fully securing the wall mounting plates on the wall.

6.0 mm

3.5 mm

6.0 mm
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12. Install the wall mount plate on the screws and slide it forward to lock in place, see the 
following figure.

Figure 2-5. Wall Mount Installation

13. Once the device is installed on the wall, tighten the screws to secure the device.

2.4. Installing and Removing SFP Modules

Up to four fiber optic ports are available (dependent on model) for use in the switch. Refer to 
the technical specifications for details.

The Gigabit Ethernet ports on the switch are 100/1000Base SFP Fiber ports, which require 
using the 100M or 1G mini-GBIC fiber transceivers to work properly. Advantech provides 
completed transceiver models for different distance requirement.

The concept behind the LC port and cable is quite straight forward. Suppose that you are 
connecting devices I and II; contrary to electrical signals, optical signals do not require a cir-
cuit in order to transmit data. Consequently, one of the optical lines is used to transmit data 
from device I to device II, and the other optical line is used transmit data from device II to 
device I, for full-duplex transmission.

Remember to connect the Tx (transmit) port of device I to the Rx (receive) port of device II, 
and the Rx (receive) port of device I to the Tx (transmit) port of device II. If you make your 
own cable, we suggest labeling the two sides of the same line with the same letter (A-to-A 
and B-to-B, as shown below, or A1-to-A2 and B1-to-B2).

2.4.1 Installing SFP Modules

To connect the fiber transceiver and LC cable, use the following guidelines:

This is a Class 1 Laser/LED product. To avoid causing serious damage to your 
eyes, do not stare directly into the Laser Beam.
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1. Remove the dust plug from the fiber optic slot chosen for the SFP transceiver.

Figure 2-6. Removing the Dust Plug from an SFP Slot

2. Position the SFP transceiver with the handle on top, see the following figure.

3. Locate the triangular marking in the slot and align it with the bottom of the transceiver.

4. Insert the SFP transceiver into the slot until it clicks into place.

5. Make sure the module is seated correctly before sliding the module into the slot. A click 
sounds when it is locked in place.

Figure 2-7. Installing an SFP Transceiver

6. Remove the protective plug from the SFP transceiver.

Do not remove the dust plug from the SFP slot if you are not installing the trans-
ceiver at this time. The dust plug protects hardware from dust contamination.

If you are attaching fiber optic cables to the transceiver, continue with the following 
step. Otherwise, repeat the previous steps to install the remaining SFP transceivers 
in the device.

Do not remove the dust plug from the transceiver if you are not installing the fiber 
optic cable at this time. The dust plug protects hardware from dust contamination.

Handle
54



SWITCH INSTALLATION
7. Insert the fiber cable into the transceiver. The connector snaps into place and locks.

Figure 2-8. Attaching a Fiber Optic Cable to a Transceiver

8. Repeat the previous procedures to install any additional SFP transceivers in the switch.

The fiber port is now setup.

2.4.2 Removing SFP Modules

To disconnect an LC connector, use the following guidelines:

1. Press down and hold the locking clips on the upper side of the optic cable.

2. Pull the optic cable out to release it from the transceiver.

Figure 2-9. Removing a Fiber Optic Cable to a Transceiver
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3. Hold the handle on the transceiver and pull the transceiver out of the slot.

Figure 2-10. Removing an SFP Transceiver

2.5. Connecting the Switch to Ethernet Ports

2.5.1 RJ45 Ethernet Cable Wiring

For RJ45 connectors, data-quality, twisted pair cabling (rated CAT5 or better) is recom-
mended. The connector bodies on the RJ45 Ethernet ports are metallic and connected to 
the GND terminal. For best performance, use shielded cabling. Shielded cabling may be 
used to provide further protection.

Figure 2-11. Ethernet Plug & Connector Pin Position

Maximum cable length: 100 meters (328 ft.) for 10/100/1000BaseT.

Replace the dust plug on the slot if you are not installing a transceiver. The dust 
plug protects hardware from dust contamination.

Table 2-1. RJ45 Ethernet Wiring for Reference

Straight-thru Cable Wiring Cross-over Cable Wiring

Pin 1 Pin 1 Pin 1 Pin 3

Pin 2 Pin 2 Pin 2 Pin 6

Pin 3 Pin 3 Pin 3 Pin 1

Pin 6 Pin 6 Pin 6 Pin 2

Handle

1

8
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2.6. Power Supply Installation

2.6.1 Overview

The switches can be powered by using the same DC source used to power other devices. A 
DC voltage range of 12 to 48 VDC must be applied between the V1+ terminal and the V1- 
terminal (PW1), see the following illustrations. A Class 2 power supply is required to main-
tain a UL60950 panel listing. The chassis ground screw terminal should be tied to the panel 
or chassis ground. A redundant power configuration is supported through a secondary 
power supply unit to reduce network down time as a result of power loss.

EKI-5000 Series support 12 and 48 VDC. Dual power inputs are supported and allow you to 
connect a backup power source.

Figure 2-12. Power Wiring for EKI-5000 Series

2.6.2 Considerations

Take into consideration the following guidelines before wiring the device:

 Screws should not be overly tightened, max. torque value: 5 lb-in [0.57 Nm].

 Wire sizes: between 24 AWG and 12 AWG.

 Calculate the maximum possible current for each power and common wire. Make sure 
the power draw is within limits of local electrical code regulations. 

 For best practices, route wiring for power and devices on separate paths.

 Do not bundle together wiring with similar electrical characteristics.

 Make sure to separate input and output wiring.

POWER DOWN AND DISCONNECT THE POWER CORD BEFORE SERVICING OR WIRING THE 
SWITCH.

Do not disconnect modules or cabling unless the power is first switched off. 
The device only supports the voltage outlined in the type plate. Do not use any 
other power components except those specifically designated for the switch device. 

Disconnect the power cord before installation or cable wiring. 

P2 P1

Chassis
GND

(pane)

One DC Supply

P2 P1

Chassis
GND

(pane)

Dual DC Supplies

Single DC Power Redundant DC Power
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 Label all wiring and cabling to the various devices for more effective management and 
servicing.

2.6.3 Grounding the Device

Electromagnetic Interference (EMI) affects the transmission performance of a device. By 
properly grounding the device to earth ground through a drain wire, you can setup the best 
possible noise immunity and emissions.

Figure 2-13. Grounding Connection

By connecting the ground terminal by drain wire to earth ground the switch and chassis can 
be ground.

Routing communications and power wiring through the same conduit may cause 
signal interference. To avoid interference and signal degradation, route power and 
communications wires through separate conduits.

Do not disconnect modules or cabling unless the power is first switched off. 
The device only supports the voltage outlined in the type plate. Do not use any 
other power components except those specifically designated for the switch device.

Before connecting the device properly ground the device. Lack of a proper ground-
ing setup may result in a safety risk and could be hazardous.

 Do not service equipment or cables during periods of lightning activity.

Do not service any components unless qualified and authorized to do so.

Do not block air ventilation holes.

Before applying power to the grounded switch, it is advisable to use a volt meter to 
ensure there is no voltage difference between the power supply’s negative output 
terminal and the grounding point on the switch.

Drain Wire with Lug

Connection to
Grounding Point
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2.6.4 Wiring a Relay Contact

The following section details the wiring of the relay output. The terminal block on the EKI-
5000 Series is wired and then installed onto the terminal receptor located on the EKI-5000 
Series. 

Figure 2-14. Terminal Receptor: Relay Contact

The terminal receptor includes a total of six pins: two for PWR1, two for PWR2 and two for a 
fault circuit.

2.6.5 Wiring the Power Inputs

There are two power inputs for normal and redundant power configurations. The power 
input 2 is used for wiring a redundant power configuration. See the following for terminal 
block connector views.

Figure 2-15. Terminal Receptor: Power Input Contacts

To wire the power inputs:

Make sure the power is not connected to the switch or the power converter before proceed-
ing.

1. Loosen the screws securing terminal block to the terminal block receptor.

Do not disconnect modules or cabling unless the power is first switched off. 
The device only supports the voltage outlined in the type plate. Do not use any 
other power components except those specifically designated for the switch device.

POWER DOWN AND DISCONNECT THE POWER CORD BEFORE SERVICING OR WIRING THE 
SWITCH.

P-Fail
V2-

PWR2DC 12-48V 1A@24V PWR1

V2+ V1- V1+

P-Fail
V2-

PWR2DC 12-48V 1A@24V PWR1

V2+ V1- V1+
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2. Remove the terminal block from the switch.

Figure 2-16. Removing a Terminal Block

3. Insert a small flat-bladed screwdriver in the V1+/V1- wire-clamp screws, and loosen the 
screws.

4. Insert the negative/positive DC wires into the V+/V- terminals of PW1. If setting up 
power redundancy, connect PW2 in the same manner.

5. Tighten the wire-clamp screws to secure the DC wires in place.

Figure 2-17. Installing DC Wires in a Terminal Block

6. Align the terminal block over the terminal block receptor on the switch.

7. Insert the terminal block and press it in until it is flush with the terminal block receptor.

Loosening 
Wire-clamp 
Screws

Installing DC 
Wires

Securing 
Wire-clamp 
Screws
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8. Tighten the screws on the terminal block to secure it to the terminal block receptor. 
If there is no gap between the terminal block and the terminal receptor, the terminal 
block is seated correctly.

Figure 2-18. Securing a Terminal Block to a Receptor
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CONFIGURATION UTILITY
3.1. Overview

This section describes the installation procedures for the Advantech EKI Device Configura-
tion Utility. 

The Configuration Utility is the software tool for setting up and monitoring the EKI-5000 
Series.

3.2. Enabling ProView Function

The configuration of a ProView switch can be accessed by using EKI Device Configuration 
Utility. To install the software utility see “Installing the Configuration Utility” on page 64.

The ProView features for the device must be enabled. The following guidelines allow you to 
enable and disable the ProView features.

To fully access all the available options in the Configuration Utility, administrative privileges 
are required. Without the use of administrative privileges, some functions of the 
Configuration Utility are not accessible.

Before continuing further, any devices selected for configuration must be connected and 
powered on, see “Installation Guidelines” on page 49.

1. From your Windows desktop, locate the Start button to open the Start Menu.

2. Navigate to All Programs > EKI Device Configuration Utility.

3. Locate Advantech EKI Device Configuration Utility and right-click on it.
From the pop-up menu, select Run as Administrator. 
See your network administrator to obtain the privileges required.

4. A security screen displays, select Yes to continue.

5. Select Search Again to detect any connected devices.

Once a device is detected, it is listed under the EKI Device listing in the Tree View.

6. Select the device to configure by clicking on it.

7. Select System tab to bring up the Enable ProView Features field.

Before a device can be configured, the ProView feature must be enabled.

Microsoft Windows XP is used as a reference for the development of the following 
guidelines. The following navigation references may differ depending on your oper-
ating system.
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8. Click the Enable ProView Features radio button and click Apply to configure the device.

Figure 3-1. Enabling ProView Features

The ProView function is enabled and the switch can be configured.

3.3. Installing the Configuration Utility

1. Insert the Advantech EKI Device Configuration Utility CD-ROM into the CD-ROM drive 
(whereas E:\ is the drive name of your CD-ROM) on the host PC.

2. Use Windows explorer or the Windows Run command to execute the setup program, 
the path for the setup program on the CD-ROM is as follows:

E:\EKI_Device_Configuration_Utility_v1.70.exe

3. If there is an existing COM port mapping utility on the host PC, remove it at this time. A 
system reboot may be necessary before continuing the installation.

Microsoft .NET Framework version 2.0 or greater is required for this application.
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4. Once the InstallShield Wizard screen displays, click Next to proceed with the installa-
tion.

Figure 3-2. InstallShield Wizard 1 of 4

5. The Software License Agreement displays, press I Agree to continue or Cancel to stop 
the installation.

Figure 3-3. InstallShield Wizard 2 of 4
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The InstallShield continues and a status screen displays. The default installation path is 
C:\Program Files\EKI Device Configuration Utility.

Figure 3-4. InstallShield Wizard 3 of 4

6. Once the installation of the package is finished a Configuration Utility Setup screen dis-
plays. Click Finish to conclude the process and exit the InstallShield Wizard.

Figure 3-5. InstallShield Wizard 4 of 4

3.4. Utility Menu Map

The EKI Configuration Utility can be installed on different operating systems, however, Win-
dows 7 is the recommended version. 
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Click Start > All Programs > EKI Device Configuration Utility > Advantech EKI Device 
Configuration Utility. The EKI Device Configuration Utility screen appears, see the follow-
ing figure.

Figure 3-6. Configuration Utility Overview

3.5. Menu Bar

Table 3-1. Configuration Utility Overview

No Item Description

1 Menu Bar Displays File, View, Management, Tools and Help.

2 Tool Bar Useful management functions’ shortcuts.

3 Tree View All devices will be searched and listed in this area. You can arrange 
different favorite group and virtual COM ports.

4 Information Panel Click on the devices or move cursor to the devices, the related 
information is shown in this area.

5 Status Bar Displays the current time.

6 Configuration Area Click on the items on the TreeView Area, the configuration page 
displays in this area.

4

3

2

6

1

5
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3.5.1 View Menu

Utility Settings

Click View > Settings to configure utility settings.

Figure 3-7. View > Settings > Main Form Setting

Table 3-2. Utility Settings > Main Form Setting

Item Description

Main Window Settings

Maximum Main Window 
On Load

Check the box to enable the limiting of main windows on-load to the 
maximum value.

Log Settings

Show Log Message 
Window

Check the checkbox to show the log message.

Save Log to File Check the checkbox to save log to file.

Browse Click Browse to choose a file to save.

Language Settings

Interface Language Click the drop-down menu to select an interface language: 
Traditional Chinese, Simplified Chinese or English.

OK Click OK to save and exit the utility setting.

Cancel Click Cancel to discard the changes.
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Figure 3-8. View > Settings > Device Manager

Apply Click Apply to save the utility setting.

Table 3-3. Utility Settings > Device Manager

Item Description

Device Manager

Tree View Grouping Click the drop-down menu to enable or disable grouping.

Show Empty Device Type 
Node

Check the checkbox to show empty device type node or not.

Expand New Appended 
Device Node

Check the checkbox to expand a new appended device node or not.

Device Auto Detection

After utility ready, start auto 
detection after X second

Enter a value to specify the time to auto detection time (-1 means 
disable auto detection).

Auto detect devices every 
X second

Enter a value to specify the time to auto detect devices.

Check device alive every X 
second

Enter a value to specify the time to check device alive.

Mark device as lost contact 
after retry for X times

Enter a value to specify the time to mark device as lost contact.

Table 3-2. Utility Settings > Main Form Setting (Continued)

Item Description
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3.5.2 Management Menu

3.5.3 Tools Menu

Serial Test Tool

The device provides a serial test tool to perform a loopback test on a device server product 
allowing you to send and receive data packets from the same serial port in order to verify if 
the switch is operational and troubleshoot serial communications.

The signal must be sent and received to the same port to properly execute this function. 
Temporarily connect the proper pins on the switch.

By using the serial test tool you can detect issues in the serial port, cables, or the firmware 
without the need of connecting to additional hardware.

Unsigned Hardware Installation

Automatic answer for 
unsigned hardware 
installation

Check the checkbox to enable or disable answer automatically for 
unsigned hardware installation.

OK Click OK to save and exit the utility setting.

Cancel Click Cancel to discard the changes.

Apply Click Apply to save the utility setting.

Table 3-4. Management

Item Description

Configuration Wizard Starts the software wizard (setup assistant) to leads you through the 
configuration process.

Clear Device List and 
Search Again

Clear all device list and re-search devices.

Search Again Re-search devices.

Add IP Address to Favorite Add one device to Favorites.

Search for a Range of IP 
Addresses

Add a group of device to Favorites.

Manual Direct Mapping 
Virtual COM Port

Click to add a target by selecting a Device Type and inputting the IP 
address, physically connecting the serial device server to the 
network is not required.

Table 3-3. Utility Settings > Device Manager (Continued)

Item Description
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Click Tools > Simple Serial Test to start a serial COM port test.

Figure 3-9. Tools > Simple Serial Test Tool

3.5.4 Help Menu

Table 3-5. Tool > Simple Serial Test Tool

Item Description

Port Click the drop-down menu to select a COM port.

Auto Scroll Message Check the checkbox to scroll message to the end automatically.

Save Log Click Save Log to choose a file to save. It is available after clicking 
Test.

Test Click Test to start testing the COM port.

Exit Click Exit to exit the test tool.

Table 3-6. Help

Item Description

Check Utility Update Select to update configuration utility.

About Select to show the information about the configuration utility.
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3.6. Tool Bar

The tool bar is a list of shortcuts for the most frequently used menu functions. Icons are pro-
vided for each function. By clicking on the icon, the most frequently used functions can be 
accessed. 

3.7. TreeView

The TreeView configuration area displays the selected device’s configurable settings. From 
this area you can directly group devices in the favorite’s list. See “Utility Menu Map” on 
page 66. 

3.8. Information Panel

The Information Panel area displays the selected device’s related information. See “Utility 
Menu Map” on page 66.

3.9. Status Bar

The Status Bar area displays the current time. See “Utility Menu Map” on page 66.

3.10. Configuration Area

The Configuration Area displays correlating information from selected menu items within the 
TreeView area. See “Utility Menu Map” on page 66.

Table 3-7. Tool Bar

Icon Item Description

Utility Settings Refer to “Utility Settings” on page 68.

Configuration Wizard Refer to “Management Menu” on page 70.

Clear Device List and 
Search Again

Refer to “Management Menu” on page 70.

Auto Search 
(Search Again)

Refer to “Management Menu” on page 70.

Add IP Address to 
Favorite

Refer to “Management Menu” on page 70.

Search for a Range 
of IP Addresses

Refer to “Management Menu” on page 70.

Manual Direct 
Mapping Virtual COM 
Port

Refer to “Management Menu” on page 70.
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MANAGING SWITCH
4.1. Discovering Switches

4.1.1 First Time Installation

Enabling ProView Function

See “Enabling ProView Function” on page 63 for further information.

Configuring Network Settings

EKI Device Configuration Utility provides two ways to configure network settings: DHCP + 
Auto IP Settings or Static Settings.

DHCP + Auto IP Settings

1. Select Ethernet under the desired device.

2. Click the drop-down menu to select DHCP + Auto-IP.

3. Click Apply to confirm the settings.

Figure 4-1. Selecting Networking Setting

Static Settings

1. Select Ethernet under the desired device.

2. Click the drop-down menu to select Static IP.

3. Enter the IP Address, Subnet Mask and Gateway.
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4. Click Apply to confirm the settings.

Figure 4-2. Configuring a Static IP Setting
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4.1.2 Discovering Switches

Auto Search

Only devices within the same network domain can be listed through the search function. 
Once a device is listed, the features and configuration details are accessible by clicking on 
the device name.

Figure 4-3. Auto Searching Screen

To search for a device:
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1. From the Tool Bar, click the Search Again  button.

Figure 4-4. Selecting Search Again

Clearing Device List and Search Again

The search list can be cleared for a new search request by clicking the Clearing Device 

List and Search Again  button. The function clears the listing of the devices. You can 
use the Search function again to detect any devices connected to the network domain.

4.1.3 Group Management

Creating Groups

Groups are best used to identify a set of devices with a common characteristic and to better 
organize the device pool. 

To create a favorite group, please follow the instructions as follows:

1. Right-click Favorite to display the settings.

2. Select Create Group to enter group name.

Access to the utility’s full function list requires administrator privileges.
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3. Enter a group name and click OK.

Figure 4-5. Adding a Group

The group is created and is available in the Favorite’s List.

Favorite's List

A favorite’s list is simple a way to organize the available devices by a category. 

There are three ways to create a favorite’s list: selecting a device, selecting an IP address, 
and selecting an IP address range. The following guidelines allow you to create a favorite’s 
list.

Adding a Device

1. Right-click a desired device to display the settings menu.
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2. Select Add to Favorite.

Figure 4-6. Adding a Switch to Favorites

In the event that there are existing groups, you can select the specific favorite group to 
include the selected device.

Adding an IP Address

1. From the Tool Bar, click the Add IP Address to Favorite  button.

2. Enter an IP address.
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3. Click OK to add the IP address into the favorites list

Figure 4-7. Add Favorite

In the event that there are existing groups, you can select the specific favorite group to 
include the selected IP address.

Adding an IP Address Range

1. From the Tool Bar, click the Search for a Range of IP Addresses  button.

2. Enter a starting and ending IP address range.
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3. Click OK to add the range into the favorites list.

Figure 4-8. Add Favorite

In the event that there are existing groups, you can select the specific favorite group to 
include the selected IP address range.

4.1.4 Configuring the System

Changing Device Name

1. Select the device to configure by clicking on it.

2. In the Configuration Area, select System tab.

3. Locate the Device Name field, and enter a device name.
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4. Click Apply to configure the device.

Figure 4-9. Changing Device Name

The device name is changed.

Setting Modbus/TCP Idle Time

1. Select the device to configure by clicking on it.

2. In the Configuration Area, select the System tab.

3. Locate the Modbus/TCP Host Idle Time(s) field.

4. Enter a variable representing the idle time for the Modbus/TCP host function. 

The device support the following information through Modbus/TCP and SCADA:

 Port Status

 Port Speed

 Flow Control

 Port Description

 Link Up Counter

 Tx Packets Counter

 Rx Packets Counter

 Tx Error Packets Counter

 Rx Error Packets Counter
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5. Click Apply to configure the function.

Figure 4-10. Setting Modbus/TCP Idle Time

The Modbus/TCP idle time is now set.

Setting Networks Parameters

For setting networks parameters, see “Configuring Network Settings” on page 75.

Setting SNMP

1. Select the device to configure by clicking on it.

2. In the Configuration Area, select SNMP tab.

The Basic and Community settings are listed for configuration.

3. In the SNMP Basic Settings selection, enter a contact and location in the respective 
fields.

4. In the SNMP Community Settings selection, the read-only and read-write strings are 
required.
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5. In the SNMP Trap Setting selection, enter the IP address of the SNMP trap server.

Figure 4-11. Setting SNMP

4.2. Modbus/TCP Mapping

The data map addresses of Advantech switches shown in the following table start from 
Modbus address 30001 for function code 4. 

In the given example, the address offset 0x1000 (hex) equals Modbus address 34097, while 
the address offset 0x1100 (hex) equals Modbus address 34353.

The information given by the Advantech is shown in hex mode.
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4.2.1 Modbus/TCP Mapping Table

Table 4-1. Modbus/TCP Mapping Table

Catelog Name Data Type Interpre-
tation

Address 
Offset 
(Hex)

Address 
3X

Description

System 
Info

Vendor ID = 
0x13FE

1 word 16 bits HEX 0x0000 30001 Vendor ID = 
0x13FE

Unit ID = 0xFF 1 word 16 bits HEX 0x0001 30002 Unit ID = 0xFF

Product Code 
= 0xC656

1 word 16 bits HEX 0x0002 30003 Product Code = 
0xC656

Vendor Name 
= “Advantech”

16 
words

32 chars ASCII 0x0010 30017 Vendor Name = 
“Advantech”

Word 0 Hi byte = 
'A'

Word 0 Lo byte = 
'd'

Word 1 Hi byte = 'v'

Word 1 Lo byte = 
'a'

Word 2 Hi byte = 'n'

Word 2 Lo byte = 't'

Word 3 Hi byte = 'e'

Word 3 Lo byte = 
'c'

Word 4 Hi byte = 'h'

Word 4 Lo byte = 
'\0'
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System 
Info

Product Name 
= "EKI-xxxx"

16 
words

32 chars ASCII 0x0020 30033 Product Name = 
"EKI-xxxx"

Word 0 Hi byte = 
'E'

Word 0 Lo byte = 
'K'

Word 1 Hi byte = 'I'

Word 1 Lo byte = '-'

Word 2 Hi byte = 'x'

Word 2 Lo byte = 
'x'

Word 3 Hi byte = 'x'

Word 3 Lo byte = 
'x'

Word 4 Hi byte = 
'\0'

Firmware Ver-
sion

2 words 32 bits HEX 0x020A 30523 Firmware Version

Word 0 Hi byte = 
major

Word 0 Lo byte = 
minor

Word 1 Hi byte = 
release

Word 1 Lo byte = 
build

Table 4-1. Modbus/TCP Mapping Table (Continued)

Catelog Name Data Type Interpre-
tation

Address 
Offset 
(Hex)

Address 
3X

Description
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System 
Info

Ethernet MAC 
Address

3 words 48 bits HEX 0x020E 30527 Ethernet MAC 
Address

Ex: MAC = 00-19-
CB-01-02-03

Word 0 Hi byte = 
0x00

Word 0 Lo byte = 
0x19

Word 1 Hi byte = 
0xCB

Word 1 Lo byte = 
0x01

Word 2 Hi byte = 
0x02

Word 2 Lo byte = 
0x03

IP Address 2 words 32 bits HEX 0x0400 31025 IP Address

Ex: IP = 
192.168.1.1

Word 0 Hi byte = 
0xC0

Word 0 Lo byte = 
0xA8

Word 1 Hi byte = 
0x01

Word 1 Lo byte = 
0x01

Port Info Port Status 1 word 16 bits HEX 0x1000 ~ 
0x101F

34097 ~ 
34128

Port Status

0x0000: Link down

0x0001: Link up

0xFFFF: No port

Port 1 Status 1 word 16 bits HEX 0x1000 34097 

Port 2 Status 1 word 16 bits HEX 0x1001 34098 

Port 3 Status 1 word 16 bits HEX 0x1002 34099 

Port 4 Status 1 word 16 bits HEX 0x1003 34100 

Port 5 Status 1 word 16 bits HEX 0x1004 34101 

Port 6 Status 1 word 16 bits HEX 0x1005 34102 

Table 4-1. Modbus/TCP Mapping Table (Continued)

Catelog Name Data Type Interpre-
tation

Address 
Offset 
(Hex)

Address 
3X

Description
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Port Info Port 7 Status 1 word 16 bits HEX 0x1006 34103 

Port 8 Status 1 word 16 bits HEX 0x1007 34104 

Port 9 Status 1 word 16 bits HEX 0x1008 34105 

Port 10 Status 1 word 16 bits HEX 0x1009 34106 

Port 11 Status 1 word 16 bits HEX 0x100A 34107 

Port 12 Status 1 word 16 bits HEX 0x100B 34108 

Port 13 Status 1 word 16 bits HEX 0x100C 34109 

Port 14 Status 1 word 16 bits HEX 0x100D 34110 

Port 15 Status 1 word 16 bits HEX 0x100E 34111 

Port 16 Status 1 word 16 bits HEX 0x100F 34112 

Port 17 Status 1 word 16 bits HEX 0x1010 34113 

Port 18 Status 1 word 16 bits HEX 0x1011 34114 

Port 19 Status 1 word 16 bits HEX 0x1012 34115 

Port 20 Status 1 word 16 bits HEX 0x1013 34116 

Port 21 Status 1 word 16 bits HEX 0x1014 34117 

Port 22 Status 1 word 16 bits HEX 0x1015 34118 

Port 23 Status 1 word 16 bits HEX 0x1016 34119 

Port 24 Status 1 word 16 bits HEX 0x1017 34120 

Port 25 Status 1 word 16 bits HEX 0x1018 34121 

Port 26 Status 1 word 16 bits HEX 0x1019 34122 

Port 27 Status 1 word 16 bits HEX 0x101A 34123 

Port 28 Status 1 word 16 bits HEX 0x101B 34124 

Port 29 Status 1 word 16 bits HEX 0x101C 34125 

Port 30 Status 1 word 16 bits HEX 0x101D 34126 

Port 31 Status 1 word 16 bits HEX 0x101E 34127 

Port 32 Status 1 word 16 bits HEX 0x101F 34128 

Table 4-1. Modbus/TCP Mapping Table (Continued)

Catelog Name Data Type Interpre-
tation

Address 
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(Hex)

Address 
3X

Description
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Port Info Port Speed 1 word 16 bits HEX 0x1100 ~ 
0x111F

34353 ~ 
34384

Port Speed

0x0000: 10M-Half

0x0001: 10M-Full

0x0002: 100M-Half

0x0003: 100M-Full

0x0004: 1000M-
Half

0x0005: 1000M-
Full

0xFFFF: No port

Port 1 Speed 1 word 16 bits HEX 0x1100 34353 

Port 2 Speed 1 word 16 bits HEX 0x1101 34354 

Port 3 Speed 1 word 16 bits HEX 0x1102 34355 

Port 4 Speed 1 word 16 bits HEX 0x1103 34356 

Port 5 Speed 1 word 16 bits HEX 0x1104 34357 

Port 6 Speed 1 word 16 bits HEX 0x1105 34358 

Port 7 Speed 1 word 16 bits HEX 0x1106 34359 

Port 8 Speed 1 word 16 bits HEX 0x1107 34360 

Port 9 Speed 1 word 16 bits HEX 0x1108 34361 

Port 10 Speed 1 word 16 bits HEX 0x1109 34362 

Port 11 Speed 1 word 16 bits HEX 0x110A 34363 

Port 12 Speed 1 word 16 bits HEX 0x110B 34364 

Port 13 Speed 1 word 16 bits HEX 0x110C 34365 

Port 14 Speed 1 word 16 bits HEX 0x110D 34366 

Port 15 Speed 1 word 16 bits HEX 0x110E 34367 

Port 16 Speed 1 word 16 bits HEX 0x110F 34368 

Port 17 Speed 1 word 16 bits HEX 0x1110 34369 

Port 18 Speed 1 word 16 bits HEX 0x1111 34370 

Port 19 Speed 1 word 16 bits HEX 0x1112 34371 

Port 20 Speed 1 word 16 bits HEX 0x1113 34372 

Table 4-1. Modbus/TCP Mapping Table (Continued)
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Port Info Port 21 Speed 1 word 16 bits HEX 0x1114 34373 

Port 22 Speed 1 word 16 bits HEX 0x1115 34374 

Port 23 Speed 1 word 16 bits HEX 0x1116 34375 

Port 24 Speed 1 word 16 bits HEX 0x1117 34376 

Port 25 Speed 1 word 16 bits HEX 0x1118 34377 

Port 26 Speed 1 word 16 bits HEX 0x1119 34378 

Port 27 Speed 1 word 16 bits HEX 0x111A 34379 

Port 28 Speed 1 word 16 bits HEX 0x111B 34380 

Port 29 Speed 1 word 16 bits HEX 0x111C 34381 

Port 30 Speed 1 word 16 bits HEX 0x111D 34382 

Port 31 Speed 1 word 16 bits HEX 0x111E 34383 

Port 32 Speed 1 word 16 bits HEX 0x111F 34384 

Flow Control 1 word 16 bits HEX 0x1200 ~ 
0x121F

34609 ~ 
34640

Flow Control

0x0000: Off

0x0001: On

0xFFFF: No port

Port 1 Flow 
Control

1 word 16 bits HEX 0x1200 34609 

Port 2 Flow 
Control

1 word 16 bits HEX 0x1201 34610 

Port 3 Flow 
Control

1 word 16 bits HEX 0x1202 34611 

Port 4 Flow 
Control

1 word 16 bits HEX 0x1203 34612 

Port 5 Flow 
Control

1 word 16 bits HEX 0x1204 34613 

Port 6 Flow 
Control

1 word 16 bits HEX 0x1205 34614 

Port 7 Flow 
Control

1 word 16 bits HEX 0x1206 34615 

Port 8 Flow 
Control

1 word 16 bits HEX 0x1207 34616 

Table 4-1. Modbus/TCP Mapping Table (Continued)
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Port Info Port 9 Flow 
Control

1 word 16 bits HEX 0x1208 34617 

Port 10 Flow 
Control

1 word 16 bits HEX 0x1209 34618 

Port 11 Flow 
Control

1 word 16 bits HEX 0x120A 34619 

Port 12 Flow 
Control

1 word 16 bits HEX 0x120B 34620 

Port 13 Flow 
Control

1 word 16 bits HEX 0x120C 34621 

Port 14 Flow 
Control

1 word 16 bits HEX 0x120D 34622 

Port 15 Flow 
Control

1 word 16 bits HEX 0x120E 34623 

Port 16 Flow 
Control

1 word 16 bits HEX 0x120F 34624 

Port 17 Flow 
Control

1 word 16 bits HEX 0x1210 34625 

Port 18 Flow 
Control

1 word 16 bits HEX 0x1211 34626 

Port 19 Flow 
Control

1 word 16 bits HEX 0x1212 34627 

Port 20 Flow 
Control

1 word 16 bits HEX 0x1213 34628 

Port 21 Flow 
Control

1 word 16 bits HEX 0x1214 34629 

Port 22 Flow 
Control

1 word 16 bits HEX 0x1215 34630 

Port 23 Flow 
Control

1 word 16 bits HEX 0x1216 34631 

Port 24 Flow 
Control

1 word 16 bits HEX 0x1217 34632 

Port 25 Flow 
Control

1 word 16 bits HEX 0x1218 34633 

Port 26 Flow 
Control

1 word 16 bits HEX 0x1219 34634 

Table 4-1. Modbus/TCP Mapping Table (Continued)
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Port Info Port 27 Flow 
Control

1 word 16 bits HEX 0x121A 34635 

Port 28 Flow 
Control

1 word 16 bits HEX 0x121B 34636 

Port 29 Flow 
Control

1 word 16 bits HEX 0x121C 34637 

Port 30 Flow 
Control

1 word 16 bits HEX 0x121D 34638 

Port 31 Flow 
Control

1 word 16 bits HEX 0x121E 34639 

Port 32 Flow 
Control

1 word 16 bits HEX 0x121F 34640 

Port Descrip-
tion

20 
words

40 chars ASCII 0x1400 ~ 
0x166C

35121 ~ 
35741

Port Description

Port Description = 
"100RX,RJ45."

 Word 0 Hi byte = 
'1'

Word 0 Lo byte = 
'0'

Word 1Hi byte = '0'

Word 1 Lo byte = 
‘R’ 

Word 2 Hi byte = 
'X'

Word 2 Lo byte = ‘,’ 

Word 3 Hi byte = 
'R'

Word 3 Lo byte = 
‘J’ 

Word 4 Hi byte = ‘4’ 

Word 4 Lo byte = 
‘5’

Word 5 Hi byte = ‘.’

Word 5 Lo byte = 
‘\0’

Table 4-1. Modbus/TCP Mapping Table (Continued)
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Port Info Port 1 Descrip-
tion

20 
words

40 chars ASCII 0x1400 35121

Port 2 Descrip-
tion

20 
words

40 chars ASCII 0x1414 35141

Port 3 Descrip-
tion

20 
words

40 chars ASCII 0x1428 35161

Port 4 Descrip-
tion

20 
words

40 chars ASCII 0x143C 35181

Port 5 Descrip-
tion

20 
words

40 chars ASCII 0x1450 35201

Port 6 Descrip-
tion

20 
words

40 chars ASCII 0x1464 35221

Port 7 Descrip-
tion

20 
words

40 chars ASCII 0x1478 35241

Port 8 Descrip-
tion

20 
words

40 chars ASCII 0x148C 35261

Port 9 Descrip-
tion

20 
words

40 chars ASCII 0x14A0 35281

Port 10 
Description

20 
words

40 chars ASCII 0x14B4 35301

Port 11 
Description

20 
words

40 chars ASCII 0x14C8 35321

Port 12 
Description

20 
words

40 chars ASCII 0x14DC 35341

Port 13 
Description

20 
words

40 chars ASCII 0x14F0 35361

Port 14 
Description

20 
words

40 chars ASCII 0x1504 35381

Port 15 
Description

20 
words

40 chars ASCII 0x1518 35401

Port 16 
Description

20 
words

40 chars ASCII 0x152C 35421

Port 17 
Description

20 
words

40 chars ASCII 0x1540 35441

Port 18 
Description

20 
words

40 chars ASCII 0x1554 35461

Table 4-1. Modbus/TCP Mapping Table (Continued)
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Port Info Port 19 
Description

20 
words

40 chars ASCII 0x1568 35481

Port 20 
Description

20 
words

40 chars ASCII 0x157C 35501

Port 21 
Description

20 
words

40 chars ASCII 0x1590 35521

Port 22 
Description

20 
words

40 chars ASCII 0x15A4 35541

Port 23 
Description

20 
words

40 chars ASCII 0x15B8 35561

Port 24 
Description

20 
words

40 chars ASCII 0x15CC 35581

Port 25 
Description

20 
words

40 chars ASCII 0x15E0 35601

Port 26 
Description

20 
words

40 chars ASCII 0x15F4 35621

Port 27 
Description

20 
words

40 chars ASCII 0x1608 35641

Port 28 
Description

20 
words

40 chars ASCII 0x161C 35661

Port 29 
Description

20 
words

40 chars ASCII 0x1630 35681

Port 30 
Description

20 
words

40 chars ASCII 0x1644 35701

Port 31 
Description

20 
words

40 chars ASCII 0x1658 35721

Port 32 
Description

20 
words

40 chars ASCII 0x166C 35741

Link Up Coun-
ter

1 word 16 bits HEX 0x1700 ~ 
0x171F

35889 ~ 
35920

Link Up Counter

Ex: port link up 
counter = 13

Received MOD-
BUS response: 
0x000D

Port 1 Link Up 
Counter

1 word 16 bits HEX 0x1700 35889

Port 2 Link Up 
Counter

1 word 16 bits HEX 0x1701 35890

Table 4-1. Modbus/TCP Mapping Table (Continued)
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Port Info Port 3 Link Up 
Counter

1 word 16 bits HEX 0x1702 35891

Port 4 Link Up 
Counter

1 word 16 bits HEX 0x1703 35892

Port 5 Link Up 
Counter

1 word 16 bits HEX 0x1704 35893

Port 6 Link Up 
Counter

1 word 16 bits HEX 0x1705 35894

Port 7 Link Up 
Counter

1 word 16 bits HEX 0x1706 35895

Port 8 Link Up 
Counter

1 word 16 bits HEX 0x1707 35896

Port 9 Link Up 
Counter

1 word 16 bits HEX 0x1708 35897

Port 10 Link Up 
Counter

1 word 16 bits HEX 0x1709 35898

Port 11 Link Up 
Counter

1 word 16 bits HEX 0x170A 35899

Port 12 Link Up 
Counter

1 word 16 bits HEX 0x170B 35900

Port 13 Link Up 
Counter

1 word 16 bits HEX 0x170C 35901

Port 14 Link Up 
Counter

1 word 16 bits HEX 0x170D 35902

Port 15 Link Up 
Counter

1 word 16 bits HEX 0x170E 35903

Port 16 Link Up 
Counter

1 word 16 bits HEX 0x170F 35904

Port 17 Link Up 
Counter

1 word 16 bits HEX 0x1710 35905

Port 18 Link Up 
Counter

1 word 16 bits HEX 0x1711 35906

Port 19 Link Up 
Counter

1 word 16 bits HEX 0x1712 35907

Port 20 Link Up 
Counter

1 word 16 bits HEX 0x1713 35908

Table 4-1. Modbus/TCP Mapping Table (Continued)
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Port Info Port 21 Link Up 
Counter

1 word 16 bits HEX 0x1714 35909

Port 22 Link Up 
Counter

1 word 16 bits HEX 0x1715 35910

Port 23 Link Up 
Counter

1 word 16 bits HEX 0x1716 35911

Port 24 Link Up 
Counter

1 word 16 bits HEX 0x1717 35912

Port 25 Link Up 
Counter

1 word 16 bits HEX 0x1718 35913

Port 26 Link Up 
Counter

1 word 16 bits HEX 0x1719 35914

Port 27 Link Up 
Counter

1 word 16 bits HEX 0x171A 35915

Port 28 Link Up 
Counter

1 word 16 bits HEX 0x171B 35916

Port 29 Link Up 
Counter

1 word 16 bits HEX 0x171C 35917

Port 30 Link Up 
Counter

1 word 16 bits HEX 0x171D 35918

Port 31 Link Up 
Counter

1 word 16 bits HEX 0x171E 35919

Port 32 Link Up 
Counter

1 word 16 bits HEX 0x171F 35920

Packet 
Info

Tx Packets 
Counter

4 words 64 bits HEX 0x2000 ~ 
0x207C

38193 ~ 
38317

Tx Packets

Ex: port 1 Tx 
Packet Amount = 
11223344

Received MOD-
BUS response: 
0xAB4130 

Word 0 = 0x0000

Word 1 = 0x0000

Word 2 = 0x00AB

Word 3 = 0x4130

Port 1 Tx Pack-
ets

4 words 64 bits HEX 0x2000 38193

Table 4-1. Modbus/TCP Mapping Table (Continued)
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Packet 
Info

Port 2 Tx Pack-
ets

4 words 64 bits HEX 0x2004 38197

Port 3 Tx Pack-
ets

4 words 64 bits HEX 0x2008 38201

Port 4 Tx Pack-
ets

4 words 64 bits HEX 0x200C 38205

Port 5 Tx Pack-
ets

4 words 64 bits HEX 0x2010 38209

Port 6 Tx Pack-
ets

4 words 64 bits HEX 0x2014 38213

Port 7 Tx Pack-
ets

4 words 64 bits HEX 0x2018 38217

Port 8 Tx Pack-
ets

4 words 64 bits HEX 0x201C 38221

Port 9 Tx Pack-
ets

4 words 64 bits HEX 0x2020 38225

Port 10 Tx 
Packets

4 words 64 bits HEX 0x2024 38229

Port 11 Tx 
Packets

4 words 64 bits HEX 0x2028 38233

Port 12 Tx 
Packets

4 words 64 bits HEX 0x202C 38237

Port 13 Tx 
Packets

4 words 64 bits HEX 0x2030 38241

Port 14 Tx 
Packets

4 words 64 bits HEX 0x2034 38245

Port 15 Tx 
Packets

4 words 64 bits HEX 0x2038 38249

Port 16 Tx 
Packets

4 words 64 bits HEX 0x203C 38253

Port 17 Tx 
Packets

4 words 64 bits HEX 0x2040 38257

Port 18 Tx 
Packets

4 words 64 bits HEX 0x2044 38261

Port 19 Tx 
Packets

4 words 64 bits HEX 0x2048 38265

Table 4-1. Modbus/TCP Mapping Table (Continued)
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Packet 
Info

Port 20 Tx 
Packets

4 words 64 bits HEX 0x204C 38269

Port 21 Tx 
Packets

4 words 64 bits HEX 0x2050 38273

Port 22 Tx 
Packets

4 words 64 bits HEX 0x2054 38277

Port 23 Tx 
Packets

4 words 64 bits HEX 0x2058 38281

Port 24 Tx 
Packets

4 words 64 bits HEX 0x205C 38285

Port 25 Tx 
Packets

4 words 64 bits HEX 0x2060 38289

Port 26 Tx 
Packets

4 words 64 bits HEX 0x2064 38293

Port 27 Tx 
Packets

4 words 64 bits HEX 0x2068 38297

Port 28 Tx 
Packets

4 words 64 bits HEX 0x206C 38301

Port 29 Tx 
Packets

4 words 64 bits HEX 0x2070 38305

Port 30 Tx 
Packets

4 words 64 bits HEX 0x2074 38309

Port 31 Tx 
Packets

4 words 64 bits HEX 0x2078 38313

Port 32 Tx 
Packets

4 words 64 bits HEX 0x207C 38317

Rx Packets 
Counter

4 words 64 bits HEX 0x2100 
~0x217C

38449 ~ 
38573

Rx Packets

Ex: port 1 Rx 
Packet Amount = 
11223344

Received MOD-
BUS response: 
0xAB4130 

Word 0 = 0x0000

Word 1 = 0x0000

Word 2 = 0x00AB

Word 3 = 0x4130

Table 4-1. Modbus/TCP Mapping Table (Continued)
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Packet 
Info

Port 1 Rx 
Packets

4 words 64 bits HEX 0x2100 38449

Port 2 Rx 
Packets

4 words 64 bits HEX 0x2104 38453

Port 3 Rx 
Packets

4 words 64 bits HEX 0x2108 38457

Port 4 Rx 
Packets

4 words 64 bits HEX 0x210C 38461

Port 5 Rx 
Packets

4 words 64 bits HEX 0x2110 38465

Port 6 Rx 
Packets

4 words 64 bits HEX 0x2114 38469

Port 7 Rx 
Packets

4 words 64 bits HEX 0x2118 38473

Port 8 Rx 
Packets

4 words 64 bits HEX 0x211C 38477

Port 9 Rx 
Packets

4 words 64 bits HEX 0x2120 38481

Port 10 Rx 
Packets

4 words 64 bits HEX 0x2124 38485

Port 11 Rx 
Packets

4 words 64 bits HEX 0x2128 38489

Port 12 Rx 
Packets

4 words 64 bits HEX 0x212C 38493

Port 13 Rx 
Packets

4 words 64 bits HEX 0x2130 38497

Port 14 Rx 
Packets

4 words 64 bits HEX 0x2134 38501

Port 15 Rx 
Packets

4 words 64 bits HEX 0x2138 38505

Port 16 Rx 
Packets

4 words 64 bits HEX 0x213C 38509

Port 17 Rx 
Packets

4 words 64 bits HEX 0x2140 38513

Port 18 Rx 
Packets

4 words 64 bits HEX 0x2144 38517

Table 4-1. Modbus/TCP Mapping Table (Continued)
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Packet 
Info

Port 19 Rx 
Packets

4 words 64 bits HEX 0x2148 38521

Port 20 Rx 
Packets

4 words 64 bits HEX 0x214C 38525

Port 21 Rx 
Packets

4 words 64 bits HEX 0x2150 38529

Port 22 Rx 
Packets

4 words 64 bits HEX 0x2154 38533

Port 23 Rx 
Packets

4 words 64 bits HEX 0x2158 38537

Port 24 Rx 
Packets

4 words 64 bits HEX 0x215C 38541

Port 25 Rx 
Packets

4 words 64 bits HEX 0x2160 38545

Port 26 Rx 
Packets

4 words 64 bits HEX 0x2164 38549

Port 27 Rx 
Packets

4 words 64 bits HEX 0x2168 38553

Port 28 Rx 
Packets

4 words 64 bits HEX 0x216C 38557

Port 29 Rx 
Packets

4 words 64 bits HEX 0x2170 38561

Port 30 Rx 
Packets

4 words 64 bits HEX 0x2174 38565

Port 31 Rx 
Packets

4 words 64 bits HEX 0x2178 38569

Port 32 Rx 
Packets

4 words 64 bits HEX 0x217C 38573

Tx Error Pack-
ets Counter

2 words 32 bits HEX 0x2200 ~ 
0x223E

38705 ~ 
38767

Tx Error Packets

Ex: port 1 Tx 
Packet Amount = 
11223344

Received MOD-
BUS response: 
0xAB4130 

Word 0 = 0x00AB

Word 1 = 0x4130

Table 4-1. Modbus/TCP Mapping Table (Continued)
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Packet 
Info

Port 1 Tx Error 
Packets

2 words 32 bits HEX 0x2200 38705

Port 2 Tx Error 
Packets

2 words 32 bits HEX 0x2202 38707

Port 3 Tx Error 
Packets

2 words 32 bits HEX 0x2204 38709

Port 4 Tx Error 
Packets

2 words 32 bits HEX 0x2206 38711

Port 5 Tx Error 
Packets

2 words 32 bits HEX 0x2208 38713

Port 6 Tx Error 
Packets

2 words 32 bits HEX 0x220A 38715

Port 7 Tx Error 
Packets

2 words 32 bits HEX 0x220C 38717

Port 8 Tx Error 
Packets

2 words 32 bits HEX 0x220E 38719

Port 9 Tx Error 
Packets

2 words 32 bits HEX 0x2210 38721

Port 10 Tx 
Error Packets

2 words 32 bits HEX 0x2212 38723

Port 11 Tx 
Error Packets

2 words 32 bits HEX 0x2214 38725

Port 12 Tx 
Error Packets

2 words 32 bits HEX 0x2216 38727

Port 13 Tx 
Error Packets

2 words 32 bits HEX 0x2218 38729

Port 14 Tx 
Error Packets

2 words 32 bits HEX 0x221A 38731

Port 15 Tx 
Error Packets

2 words 32 bits HEX 0x221C 38733

Port 16 Tx 
Error Packets

2 words 32 bits HEX 0x221E 38735

Port 17 Tx 
Error Packets

2 words 32 bits HEX 0x2220 38737

Port 18 Tx 
Error Packets

2 words 32 bits HEX 0x2222 38739
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Packet 
Info

Port 19 Tx 
Error Packets

2 words 32 bits HEX 0x2224 38741

Port 20 Tx 
Error Packets

2 words 32 bits HEX 0x2226 38743

Port 21 Tx 
Error Packets

2 words 32 bits HEX 0x2228 38745

Port 22 Tx 
Error Packets

2 words 32 bits HEX 0x222A 38747

Port 23 Tx 
Error Packets

2 words 32 bits HEX 0x222C 38749

Port 24 Tx 
Error Packets

2 words 32 bits HEX 0x222E 38751

Port 25 Tx 
Error Packets

2 words 32 bits HEX 0x2230 38753

Port 26 Tx 
Error Packets

2 words 32 bits HEX 0x2232 38755

Port 27 Tx 
Error Packets

2 words 32 bits HEX 0x2234 38757

Port 28 Tx 
Error Packets

2 words 32 bits HEX 0x2236 38759

Port 29 Tx 
Error Packets

2 words 32 bits HEX 0x2238 38761

Port 30 Tx 
Error Packets

2 words 32 bits HEX 0x223A 38763

Port 31 Tx 
Error Packets

2 words 32 bits HEX 0x223C 38765

Port 32 Tx 
Error Packets

2 words 32 bits HEX 0x223E 38767

Rx Error Pack-
ets Counter

2 words 32 bits HEX 0x2300 ~ 
0x233E

38961 ~ 
39023

Rx Error Packets

Ex: port 1 Rx 
Packet Amount = 
11223344

Received MOD-
BUS response: 
0xAB4130 

Word 0 = 0x00AB

Word 1 = 0x4130
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Catelog Name Data Type Interpre-
tation

Address 
Offset 
(Hex)

Address 
3X

Description
103



MANAGING SWITCH
Packet 
Info

Port 1 Rx Error 
Packets

2 words 32 bits HEX 0x2300 38961

Port 2 Rx Error 
Packets

2 words 32 bits HEX 0x2302 38963

Port 3 Rx Error 
Packets

2 words 32 bits HEX 0x2304 38965

Port 4 Rx Error 
Packets

2 words 32 bits HEX 0x2306 38967

Port 5 Rx Error 
Packets

2 words 32 bits HEX 0x2308 38969

Port 6 Rx Error 
Packets

2 words 32 bits HEX 0x230A 38971

Port 7 Rx Error 
Packets

2 words 32 bits HEX 0x230C 38973

Port 8 Rx Error 
Packets

2 words 32 bits HEX 0x230E 38975

Port 9 Rx Error 
Packets

2 words 32 bits HEX 0x2310 38977

Port 10 Rx 
Error Packets

2 words 32 bits HEX 0x2312 38979

Port 11 Rx 
Error Packets

2 words 32 bits HEX 0x2314 38981

Port 12 Rx 
Error Packets

2 words 32 bits HEX 0x2316 38983

Port 13 Rx 
Error Packets

2 words 32 bits HEX 0x2318 38985

Port 14 Rx 
Error Packets

2 words 32 bits HEX 0x231A 38987

Port 15 Rx 
Error Packets

2 words 32 bits HEX 0x231C 38989

Port 16 Rx 
Error Packets

2 words 32 bits HEX 0x231E 38991

Port 17 Rx 
Error Packets

2 words 32 bits HEX 0x2320 38993

Port 18 Rx 
Error Packets

2 words 32 bits HEX 0x2322 38995

Table 4-1. Modbus/TCP Mapping Table (Continued)

Catelog Name Data Type Interpre-
tation

Address 
Offset 
(Hex)

Address 
3X

Description
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Packet 
Info

Port 19 Rx 
Error Packets

2 words 32 bits HEX 0x2324 38997

Port 20 Rx 
Error Packets

2 words 32 bits HEX 0x2326 38999

Port 21 Rx 
Error Packets

2 words 32 bits HEX 0x2328 39001

Port 22 Rx 
Error Packets

2 words 32 bits HEX 0x232A 39003

Port 23 Rx 
Error Packets

2 words 32 bits HEX 0x232C 39005

Port 24 Rx 
Error Packets

2 words 32 bits HEX 0x232E 39007

Port 25 Rx 
Error Packets

2 words 32 bits HEX 0x2330 39009

Port 26 Rx 
Error Packets

2 words 32 bits HEX 0x2332 39011

Port 27 Rx 
Error Packets

2 words 32 bits HEX 0x2334 39013

Port 28 Rx 
Error Packets

2 words 32 bits HEX 0x2336 39015

Port 29 Rx 
Error Packets

2 words 32 bits HEX 0x2338 39017

Port 30 Rx 
Error Packets

2 words 32 bits HEX 0x233A 39019

Port 31 Rx 
Error Packets

2 words 32 bits HEX 0x233C 39021

Port 32 Rx 
Error Packets

2 words 32 bits HEX 0x233E 39023

Table 4-1. Modbus/TCP Mapping Table (Continued)

Catelog Name Data Type Interpre-
tation

Address 
Offset 
(Hex)

Address 
3X

Description
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